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Before the Migration 

Send us the audit document you have generated using the files included in the zip ClicknDECiDE_NSI_ 

Migration_Request.zip found here: 

http://www.clickndecide.com/downloads/WebDoc/Support/ClicknDECiDE_NSI_Migration_Request.zip 

Once done, we will provide you a new license for the Click & DECiDE - NSI 11.1. 

Download the last release of Click & DECiDE here: 

http://license.clickndecide.com/downloads/cndnsi_request.aspx  

 

Note: the operations described in this article require a full access to the computer. Be sure to be 
logged as an Administrator. 
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Section 1: Backup your current configuration 

Backup your License Certificates 

Save your Click and DECiDE license at:  
C:\Program Files\Click and DECiDE\NSI\_license.cert (by default). 

Backup NSI Configuration 

1. Start the Management Console: Start>All Programs>Click and DECiDE\Network Security 
Intelligence>Management Console. 

2. Navigate to NetReport/localhost (by default). 

3. Click on Backup 

 

4. Save the new folder named AAAAMMDD-HHMM-user-v1002 created in  
C:\Program Files\ Click and DECiDE\NSI\ConfigurationBackup (by default). 

5. Browse to the filter lists NetReport/localhost/ULA/Filters (by default). 

mailto:sales@clickndecide.com
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6. Right click on a filter and select Export filters and parsers… 

 

7. Save the configuration for this filter. 

8. Repeat step 6. and 7. for every filters except Database Management, Click and Decide Alert, Click 
and Decide Audit and EngineEvent. 

9. Close the Management Console. 

 

Backup the WebPortal Configuration 

1. Start the Web Portal Administrator: Start>All Programs>Click and DECiDE> Administration 
Manager. 

mailto:sales@clickndecide.com
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2. Go to File>Backup Security Database 

 

3. Save the Security Database configuration into a .cndbck file. 

4. Close Click and DECiDE Administration Manager. 

5. Save your own Builder projects (*.wfv files) created with the BAI toolkit. We recommend to put these file 
in the MyProject folder located at: 
C:\Program Files\Click and DECiDE\Business Application Intelligence\Runtime_Projects\My 
Projects (by default). 

6. Save the external files (for example, the images) used by your own Builder projects. We recommend to 
put these file with the other image files in the Runtime_projects folder located at: 
C:\Program Files\Click and DECiDE\Business Application Intelligence\Runtime_Projects (by 

default). 

7. Save your customized standard reports and cubes (if applicable) respectively located in: 
C:\Program Files\Click and DECiDE\Business Application Intelligence\Runtime_Projects\enu (by 
default) and 
C:\Program Files\Click and DECiDE\Business Application Intelligence\Runtime_Projects\cubes 

(by default). 

8. Save your previously generated reports located in: 
C:\Program Files\Click and DECiDE\Business Application Intelligence\Runtime_Projects\Static (by 

default). 

mailto:sales@clickndecide.com
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9. Save your customized menus (if applicable): these are the *.wmu files in the Runtime_projects folder 
located at: 
C:\Program Files\Click and DECiDE\Business Application Intelligence\Runtime_Projects (by 

default). 

10. Save the scheduled tasks configuration file d7tasks.xml located at: 
C:\Program Files\Click and DECiDE\Business Application Intelligence\d7tasks.xml (by default). 

11. Save your own script (if applicable) which are located at:  
C:\Program Files\Click and DECiDE\Business Application Intelligence\TaskScripts (by default). 

Backup the database files 

1. Stop the NSI services by running the stopsvc.bat batch file located at: 
C:\Program Files\Click and DECiDE\NSI\stopsvc.bat (by default). 

2. Stop the BAI services by running the stopsvc.bat batch file located at: 
C:\Program Files\Click and DECiDE\BAI\stopsvc.bat (by default). 

3. Start SQL Server Management Studio: Start>All Programs>Microsoft SQL Server 2005>SQL 
Server Management Studio. 

4. Choose Windows Authentication 

 

5. Navigate to Databases/netreport. 

mailto:sales@clickndecide.com
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6. Right Click on netreport and select Tasks>Detach… 
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7. Click OK. 

 

8. Backup the netreport database files, netreport.mdf and netreport_log.ldf  located in: 
C:\Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\Data (by default) 

9. In SQL Server Management Studio, navigate to Databases. 

mailto:sales@clickndecide.com
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10. Right click on Databases and select Attach… 

 

11. Click Add… 
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12. Browse to the netreport.mdf database file. 
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13. Click OK. 

 

14. Click OK. 

15. Close SQL Server Management Studio. 
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Section 2: Update Click & DECiDE - NSI 

Download and extract the Click & DECiDE - NSI setup 

1. Download the Setup of Click&DECiDE 11.01.04, CnD-NSI.11.01.04.exe,  available at: 

http://license.clickndecide.com/downloads/cndnsi_request.aspx 

2. Run the CnD-NSI.11.01.04.exe setup. 

3. Choose where you want to extract the files required for the installation. 

 

4. Click Next. 

5. Wait for the extraction to complete. The Click and DECiDE - NSI Installation Wizard will launch. 

 

The Click and DECiDE - NSI Installation Wizard 

1. If you have any prerequisites, click Install to install them. 

mailto:sales@clickndecide.com
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2. On the Updating a previous version dialog, select I want to continue and click OK.

 

3. On the Welcome to Installshield Wizard for Click and DECiDE - NSI dialog, click Next. 

4. On the License Agreement dialog, read the license agreement and select I accept the terms in the 
license agreement to continue. 

 

5. Click Next. 

6. On the Destination Folder dialog, select a folder on a partition with enough hard disk space. See 
recommendations: 
http://www.clickndecide.com/downloads/WebDoc/Support/ClicknDECiDE_NSI_Database_Archive_Disk_

mailto:sales@clickndecide.com
http://www.clickndecide.com/
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Size.zip 

 

7. Click Next. 

8. On the Setup Type dialog, choose Click and DECiDE NSI Typical Solution. 

 

9. Click Next. 

10. Click Install. 

mailto:sales@clickndecide.com
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11. Wait for the installation to complete. 

12. On the Installshield Wizard Completed dialog, click Finish. 

 

13. The installation asks for a reboot. Save all your documents and close all your application and click Yes. 

 

mailto:sales@clickndecide.com
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The Click and DECiDE Configurator – Log Source Configuration 

1. After rebooting your machine, the Log Source Configuration launches and asks for a License 
Certificate. 

 

2. Click Change… 

mailto:sales@clickndecide.com
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3. Select the License Certificate we sent you for Click & DECiDE - NSI 11.1.4. 

 

4. Click OK. 

 

  

mailto:sales@clickndecide.com
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5. On the Database Settings dialog 

a. If you have configured a local Database Server, click OK. 

 

b.  If you have configured a remote Database Server,  you need to run the SQL Server 
Configurator Tool: 

i. Connect to the machine where the SQL Server is running 

WARNING: this operation requires SQL Server Administrator privileges. Be sure to connect 

as a user that has such privileges. 

ii. Locate the Installation Files of Click & DECiDE - NSI. 

iii. Run the SQL Server Configuration Tool from the local disk: 
SQL Server Configurator\DVSqlServerConfig.exe 

WARNING: the SQL Server Configuration Tool has to run from a local disk. Be sure to copy 

the SQL Server Configurator folder on your local disk before running the program. 

iv. Enter the full name and the password of the user used by Click & DECiDE - NSI to 
connect to the database 

 

 

mailto:sales@clickndecide.com
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v. Enter the name of the SQL Server Instance. 

INFORMATION: the SQL Server instance is the name that appears between brackets after 
the name of the SQL Server service (Start>Administrative Tools>Services). 

 

vi. Click OK. 

vii. On the Click & DECiDE – NSI machine, click OK. 

 

mailto:sales@clickndecide.com
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viii. Click Close. 

 

6. Click OK and confirm you want to continue. 

Section 3: Restore your configuration 

 Restore the WebPortal Configuration  

This step is necessary if you have modified the “Click and DECiDE NSI Scheduled 
Dashboards” standard planification, or if you have added new export tasks. 

If you have modified standard tasks, they are automatically migrated and you don’t need 
to follow this migration step. 

 

1. Locate the Security Database backup file (.cndbck) from Section 1.C.3 on your hard drive. 

2. Double click on the file. Administration Manager asks if you want to restore the Security Database. 

 

3. Click Yes. 

 

mailto:sales@clickndecide.com
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4. Click Update Security icon 

 

5. Click OK. 

6. Close Administration Manager. 

Restore the scheduled tasks 

This step is necessary if you have modified the “Click and DECiDE NSI Scheduled 
Dashboards” standard planification. 

If you have modified standard tasks, they are automatically migrated and you don’t need 
to follow any migration step.  

If you have created new export taks, they are correctly migrated after the previous step 
“Restore the WebPortal Configuration”, and you don’t need to follow this migration step. 

1. Open Web Portal: Start>All Programs>Click and DECiDE>BAI. 

2. Login as a member of NSI Admin. 

mailto:sales@clickndecide.com
http://www.clickndecide.com/


 

21 
 

 

 

www.clickndecide.com Contact us: E-mail: sales@clickndecide.com  Tel: +33 (0)6 71 99 86 60 
Sales Offices: 98, route de la Reine - 92100 Boulogne-Bt, France.  
To contact your nearest Click&DECiDE partner, click here. 

Network Security Intelligence | KBA 

3. In the Scheduled Tasks and Tasks section, click on the Import tasks image button: 

 

4. Click on the Continue button:

 

7. Select on your hard drive the backup of the d7tasks.xml created in Section 1.C.10.:

 

5. Click on the Import button. 

6. Check the new tasks have been correctly imported by editing one of them. 

 

mailto:sales@clickndecide.com
http://www.clickndecide.com/


 

22 
 

 

 

www.clickndecide.com Contact us: E-mail: sales@clickndecide.com  Tel: +33 (0)6 71 99 86 60 
Sales Offices: 98, route de la Reine - 92100 Boulogne-Bt, France.  
To contact your nearest Click&DECiDE partner, click here. 

Network Security Intelligence | KBA 

Restore your custom NSI Log Sources Configuration 

1. Open the Management Console:  
Start>All Programs>Click and DECiDE>Network Security Intelligence>Management Console. 

2. Go to NetReport/localhost/Backups, you should see your previous configuration AAAAMMDD-HHMM-
user- v1002 folder (see Section 1.B.4). 

3. Navigate and select a custom initialisation or action you want to restore. For example: the RDNS net 
area initialisation. 

 

4. Click on Copy icon at the bottom of the page. 

5. Navigate where you want to paste the initialisation or action. For example: 
NetReport/localhost/ULA/Settings/Initialisations. 

mailto:sales@clickndecide.com
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6. Select the existing initialization or action (if it exists). 

 

7. Click on Delete icon. 

8. Click on Paste icon. 
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9. Rename the pasted initialization or action. Remove Copy of. 

10. Repeat step 9. to 16. for every initialization or action you want to restore. 

11. Navigate to NetReport/localhost/ULA. 

12. Click Apply Changes. 

 

13. Open the NetReport/localhost/Agents subtree. 

14. Navigate to a node with an asterix (*). 

mailto:sales@clickndecide.com
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15. Click Apply Changes. 

 

16. Repeat step 21. and 22. for every agent with an asterix (*). 

Note : for the Microsoft WMI or the Remote Microsoft WMI, you may need to copy and paste 
specific agent configuration form the backup. 

17. Close the Management Console. 

mailto:sales@clickndecide.com
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Section 4: Check your configuration 

 

Log Acquisition 

1. Start the log treatment. 

2. Open the Performance Counters:  
- On a 32-bit OS, click in the Start Search box, type perfmon , and press ENTER. 
- On a 64-bit OS, click in the Start Search box, type SystemRoot%\SysWOW64\perfmon.exe, and 

press ENTER. 
 

3. Click the + in the toolbar. 
 

4. Select the Click and DECiDE Filter Engine Performance object and select All instances. 

 

5. Click Add>>. 

6. Click OK. 

mailto:sales@clickndecide.com
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7. Check that you don’t have any nelrf (Click And DECiDE events) in the error queue. 

 

Note: the engine queues are stored in the folder C:\Program Files\Click and 
DECiDE\NSI\Error agent Storage. You can modify the destination of these files by changing the 
registry value: 
HKEY_LOCAL_MACHINE\SOFTWARE\NetReport\MC\Agents\Error\StoragePath. 
You have to restart the Click & DECiDE Filter Engine service after any change 

 

Log Insertion 

7. Open Web Portal: Start>All Programs>Click and DECiDE>BAI. 

8. Login as a member of NSI Admin. 

9. Navigate to NSI Utilities/Database Status. 

mailto:sales@clickndecide.com
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10. Open the project for the category of the log you have acquired. For example: ProxyStatistics Utilities. 

 

11. Open the report 2 - Number of Records in the Proxy Tables. 
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12. Enter the time interval corresponding to the date of your logs. For example, if you are parsing logs from 
10 days ago, enter 10 in the first text box. 
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13. Click Run. 

 

14. Check that logs are inserted into the rawdata tables. 

 

Report Generation 

1. Open Web Portal: Start>All Programs>Click and DECiDE>BAI. 

2. Login as a member of NSI Admin. 
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3. In the Scheduled Tasks & Tasks section, navigate to Scheduled Tasks/Click and DECiDE NSI 
Scheduled Dashboards. 

 

 

1. Click on Run the Scheduled Task in the right panel. 

2. Click OK.  
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3. Wait for the task to complete (it may take some time depending on the volume of your logs). 

 

4. Navigate to NSI Reports and Analysis/Published Report in the Menus section. 

mailto:sales@clickndecide.com
http://www.clickndecide.com/


 

33 
 

 

 

www.clickndecide.com Contact us: E-mail: sales@clickndecide.com  Tel: +33 (0)6 71 99 86 60 
Sales Offices: 98, route de la Reine - 92100 Boulogne-Bt, France.  
To contact your nearest Click&DECiDE partner, click here. 

Network Security Intelligence | KBA 

5. Select the category of the log you have acquired. For example: Proxy. 

 

6. Check that a report has been generated. If you have inserted yesterday’s logs, the reports should contain 
some data. 

 

Event Viewer 

1. Open the Event Viewer: Start>Administrative Tools>Event Viewer. 
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2. Select the Application event log. 

 

3. Check that there are no error from a Click and DECiDE process. 
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